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CIS 130 MICROCOMPUTERS OFFICE 2000~ 2¢/& TEST
LESSON 1 OFFICE 2000 BASICS AND THE INTERNET

FILL IN THE BLANKS

Complete the following sentences by writing the correct word or words in the blanks provided.

1. The Office application that enables you to create documents such as letters and reports is
called

2. The Office spreadsheet application is called

3. The Office application that organizes information in database format is called

4. The Office application that enables you to create slides, outlines, speaker’s notes, and
audience handouts is called

5. The Office schedule/organization application is called

6. The Office Web page application 1s called

TRUE/FALSE

Circle T if the statement is true or F if the statement 1s false.

T F 1. The only way to start an Office 2000 application is from the Programs menu on the
Start menu.

¥ 2. In Office applications, you open, save, and close files in the same way.

T 3. If you click Documents on the Start menu, a menu will open, listing the five most
recently used documents.

T F 4. You can get assistance on topics relating to the application you are using by
accessing the Help menu from the menu bar.

T F 5. Toolbars automatically display buttons for both basic and advanced commands.

T F 6. Filenames are limited to eight characters.

T F 7. One way to close an Office document is by clicking the Close button on the right
side of the menu bar.

T F 8 When vou first use an Office 2000 application, you will see an expanded meny
showing all the commands.

T F 9. The default Office Assistant character is an animated wizard.

T F 10. A Web browser is software used to display Web pages on your computer mouitor.

DEFINITIONS

Briefly define each term,

1
i

integrated software package
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CIS 130 MICROCOMPUTERS ADVANCED EXCEL 2000 2¢ /&
LESSON 11 QUIZ

TRUE/FALSE

Cirecle T if the statement is true or F if the statement is false.

T ¥ 1. The Outline feature lets you hide rows in a worksheet that do not contain formulas,

T F 2. Outlines can be used in any worksheet, regardless of whether it contains formulas.
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Excel can instantly calculate subtotals and averages within the worksheet data
without you having to enter formulas.

T F 4. Creating subtotals is a quick way to permanently enter formulas into the worksheet,

T F 5. Youcannot print a worksheet in which an outline has been applied.

CIS 130 MICROCOMPUTERS ADVANCED EXCEL 2000
LESSON 12 QuUiZ

TRUE/FALSE
Circle T if the statement is true or F if the statement is false.
T F 1. Youusethe WordArt tool on the Drawing toolbar to insert a comment on a
worksheet.

T F 2. When drawing a rectangle or oval, you can only drag from the upper-left corner to
the lower-right corner to create the object.

T F

¥R

You can insert text into an AutoShape.

FILL IN THE BLANKS

Complete the following sentences by writing the correct word or words in the blanks
provided.

. To create graphic objects you displav the toolbar,

2. Todraw a square or circle, drag from the upper-left comer to the lower-right corner while
holding down the key.
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Emily bought a new car for §11,400. She used the car three years and then traded it in for
$5,100. Find the average annual depreciation.

a. $16,500.00
b. $6,300.00
c. $223.53

d. §2,100.00

Trisha wants to buy a condominium. The estimated expenses in the first year will be
nortgage interest, $3,819; real estate taxes, $1,381; insurance, $257; depreciation, $1,370;
maintenance and repairs, $425; lost income on cash invested, $285. She also estimates that
she will save §1,400 in income taxes because of home expenses. What is the net cost of

owning a home i the first year?
a $3,819

b. $6,837
¢. $R.237
.d. $1,400

Louls is paid a salary of $500 a month, a 1% commission on all sales, and 2% mdre or
monthly sales over $8,500. In June his sales were $12,500 and in July, $14,300. His fotal
salary and commission in July 1s?

a. $14300
b. §705

c. 51,454
d. $759

Johnnv H warks on a straight commission basis and sold five copy machines at $4.500
each. The commission rate was 6%. What ig the amount of commission Johnny was paid?
a. $1,350
b

Audrey’s taxable income is $22,921. The AZ income tax rate op her taxable income is
$840 plus 6% of the amount over $20,000. What is Audrey’s tax?
a2 $2,291.00

b. §1375.26
¢. $1015.26
d. $840.00
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TRUE/FALSE

Circle T if the statement is true or F if the statement is false.
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You can save time and effort before printing by viewing the worksheet on-screen to
help identify problems.

The Margins button in the Print Preview screen 18 used to change vour page margins.
You can insert custom page breaks in a worksheet.

‘When you enter a formula in a cell, the results show in the cell and the formula
appears in the formula bar,

MULTIPLE CHOICE

Select the best response for the following statement.

L.

The Page Setup dialog box will allow you to:

a
b.

C.

print gridlines.

print column letters across the top of the worksheet.

print the row numbers down the left side of the worksheet.
print column or row labels.

all of the above.

TRUE/FALSE

“QCirele T if the statement is true of F if the statement is false.

F
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4.

Excel cannot read database files other than those created in Access.

The Text Import Wizard starts automatically when you try to open a text file in
Excel.

Excel workbooks cannot be saved in an HTML format.

The compatibility features in Microsoft Office allow you (o drag and drop
information between Office programs.

You cannot use Excel’s caleulation and analysis features en imported data.
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Test Name

Office employees must use their computational skills as 2 normal part of their daily routine.
To demonstrate your skill in computing, complete the following exercises. Record answers
on this sheet. Total value for test is 40 points—2 points per question.

1,333+ 111 +504—-73-42+517+16+975—63 —44+ 29 L

2. What is 14% of §4,0007 2

3. What is 27% of $50,000?

Lad

4. Three-sevenths is the same as what percent? 4.

5. $2,700 is what percent of $5,8007 5

6. What will a customer pay for a $14.32 order if a 15% discount
1s allowed? 6.

7. What will an employee be paid who worked a 40-hour week at $6.75
per hour and five hours overtime when the overtime rate is time-
and-a-half?

~J

8. Find the average cost of items listed below. The prices are
$4.32, $4.74, 85.18, $8.12, $9.30, and $7.72. 8.

9. Find the interest on $224,500 for 60 days at 12%. g,

10. If your business made $455.00 the first week and 635.00 the
second week, what is the percent of increase? 10.

***TFigure the cost involved in preparing an invoice as indicated below:
11. Four copies of An Economic Analysis of the Paper Industry @ $20. 11,

12. Two copies of History of Paper Making in North America @ $50. 12,

13. Three copies of Handbook of Paper Technology @ $42. 13,
"14. Total cost of merchandise before discounti ng. 14.
15. Discount of 6% on the total order. 15.
16. Total cost after discounting. 16.
17. Figure at 4% sale tax. What is the amount of the tax? L7
18. Total cost including sales tax. 18.

19. Add shipping charge of $2.32 and special handling fee of $1.50.
What i1s the total of these additional charges? 19;

20. Net amount of the invoice. 20




CIS 130 MICROCOMPUTERS WORD BASICS TEST

LESSON 3 BASIC FORMATTING
FILL IN THE BLANKS

Complete the following sentences by writing the correct word or words in the blanks provided.

1. Designs of type are called , Or typefaces.

2. Afont refers to certain standard changes in the appearance of a font,

3. A standard font size for text is point.

4. To emphasize an important part of a document, you can it in color,

e refers to the way text is positioned between the margins.
TRUE/FALSE

Circle T if the statement is true or F if the statement is false.
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Sans serif fonts are often used for the body of a document.

The only way to change the font in a Word document is by using the Font dialog
box.

The easiest way to change a font style is to select the text and click the appropriate
button on the Formatting toolbar.

Word allows you to apply only one font style at a time to selected text.
Word allows you to apply only one font size at a time to selected text.
A 10-point font is larger than an 18-point font.

If you have a printer with black ink or toner only, you cannot change text on vour
screen to colors.

The Title Case option in the Change Case dialog box capitalizes the first letter of
every word in the selected text, and other characters are lowercased.

The default alignment sefting in Word is right alignment.

Long documents are easier to read when they are center-aligned.

 WRITTEN QUESTIONS

Write your answers to the following questions.

I

~

What is the difference between serif and sans serif fonts? When is each typically nsed?

Describe three ways to change fext in a document to bold.

e
yooLLEdy &




Qf% # 22—

CIS 130 MICROCOMPUTERS WORD 2000
LESSON 2 QUIZ

FILL IN THE BLANKS

Complete the following sentences by writing the correct word or words in the blanks
provided,

1. In Overtype mode, the text you key replaces fext.

2. The is a temporary storage place in memory that makes moving
and copying text easy.

When copying or moving text a short distance. you can use a quick method called

Lid

4. Double-click to quickly select a(n)

5. Pressing removes the character to the right of the insertion
point.
MULTIPLE CHOICE

Select the best response for the following statements.

1. Small lines at the ends of characters are called
a. points.

b. serifs,
C. cases.
d. formats.

2. Which of the following is not an example of a font style?

a. bold
b. italic
¢. underline
d. color
3. Font size is determined by measuring the height of characiers in units called
a. points,
b. serifs.

€. Inches.

d. cases.

4. Strikethrough, shadow, and outline are all examples of
a. font styles.

b. font eifects.
¢. font cases.
d. font formats.
5. Which option in the Change Case dialog box would you use to capitalize the first Jetter of
the first word in a selected block of text and lowercase the res(?
a. Uppercase

b. Lowercase

c. Sentence case A
A T ks wasin
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CIS 130 MICROCOMPUTERS EXCEL BASICS
LESSON 4 WORKSHEET FORMULAS

TRUE/FALSE

Circle T if the statement is true or F if the statement is false.

T F 1. Excel recognizes the contents of 2 cell as a formula when a minus sign (-) is the
first character in a cell.

T F 2. Anoperator is a number or cell reference used in formulas.

T F 3. Informulas, contents within parentheses are evaluated first.

1T F 4. One way to edit a formula that is already entered in the worksheet is to highlight
the cell, press F5, and key or delete data as needed.
T F 5. Arelative cell reference does not change when moved or copied to a new cell,

T F 6. Thesum of a range is indicated by a special formula in the formula bar called a
function formula.

T F 7. Toreplace the values in the cells of a worksheet with the formulas that created
them, choose Options on the Tools menu, click the View tab, click the Formulas
box in the Window Options box, and then click OK.

T F 8 Todelay calculation, click the Manual button on the Calculation tab of the Options
dialog box, and then click F2 to start the calculation.

MULTIPLE CHOICE

Select the best response to the following statements.

1. In the formula =B4+7, what are the operands?
4 =

b. B4

c. +

d. B4 and7

2. The formula =B3"3
a. divides the value in B3 by 3.
b. raises the value in B3 to the third power.
c. multiplies the value in B3 by 3.
d. subtracts 3 from the value in B3.

3. If you enter a formula with an incorrect structure,

a. the cell contaiming the formula will begin blinking.

b. the cell containing the fonnula will change color.

c. a series of number signs (#####) will appear in the cell,

d. a dialog box explaining the error and how to correct it will appear.
4. The formula =$AF7+3AI8 uses

4. absolute cell references,

b. relative cell references.




Page 1

From the desk of: Mr. Butler—Foster Meade CTC Room 107
Email: arlen.butler@lewis.kyschools.us
Arlen Butler, Computer/Business Instructor

Digital Literacy, Advanced Computers, MOS Classes and Financial Services (all classes)
Non-Traditional Instructional Day (NTI DAY) Days 21-30. Use Word and just key in the
best answers and send to me via email. If you have any questions please email me and I will
get right back to you ASAP.

ONLY KEY IN ANSWERS—NOT ALL OF THE QUESTIONS!!!

Complete the NTI packet for each specific day of nontraditional day.

NTI DAY #21, complete Page 1, Key in best answer for each question
NTI DAY #22, complete Page 2, Key in best answer for each question
NTI DAY #23, complete Page 3. Key in best answer for each question
NTI DAY #24, complete Page 4, Key in best answer for each question
NTI DAY #25, complete (3), (5) Minute Timed Writing Test—DO NOT send me a copy
NTI DAY #26., complete Page 5, Key in best answer for each question
NTI DAY #27, complete Page 6, Key in best answer for each question
NTI DAY #28, complete Page 7, Key in best answer for each question
NTI DAY #29, complete Page 8, Key in best answer for cach question
NTI DAY #30, complete (3), (5) Minute Timed Writing Test—DO NOT send me a copy

Complete only the actual day that we have the NTI Day. Must be turned in for a grade value of
50 possible points—each day.

Good Luck!

Arlen Butler




